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PowerPoint is an intuitive, powerful presentation graphics program that enables you to create dynamic, 
multimedia presentations for a variety of functions. There are a lot of short online tutorials to help you 
with more specific learning in Microsoft Office PowerPoint 2007. 

 
Main Office 2010 Training Page: http://office.microsoft.com/en-us/getstarted/FX101055081033.aspx 
Video Demo: http://office.microsoft.com/training/training.aspx?AssetID=RC100687671033 

 
Content 
•Inserting a Sound Clip  •Acquiring More Sounds  •Inserting a Video into a Presentation •Setting Movie 

Options 

Multimedia, also called rich media, includes video (which PowerPoint calls movies) and audio (which 
PowerPoint calls sound) that can enhance a presentation. Multimedia may be incorporated so simply as 
to play an audible click when navigating to subsequent slides during a presentation. Although 
multimedia can add excitement to your presentation, it can become overwhelming and distracting if used 
in excess. 

 
Types of Multimedia: 

 
Sound – This includes short sound effects such as a click or creaking door as well as entire songs or 
narration soundtracks. Most users are familiar with MP3 and WAV sound files, but PowerPoint supports 
several additional types of sound files. 

 
Movies – What some might call video, PowerPoint refers to as movies. This can include home movies 
from your camcorder or downloaded movies from the Internet. PowerPoint does not let you create the 
movie itself. You will need to create your MPG or AVI file in advance. 

 
Animated GIFs – Animated GIFs, which are simple animated clip art images, are available through 
PowerPoint’s Clip Art panel. There are also thousands of sources on the Internet for free animate GIF 
downloads. 

 
IT IS IMPORTANT TO STORE ALL MULTIMEDIA FILES INCLUDING SOUND, MOVIES, AND 
ANIMATED GIFS IN THE SAME FOLDER AS THE POWERPOINT PRESENTATION ITSELF. 

 

 

1.  Inserting a Sound Clip 
 

PowerPoint comes with a library of sounds you can add to presentations or you can use your own. 
There are three Play Sound options: 

 
a.   Automatically: This setting starts playing the sound automatically when the slide loads. 

Navigating to the next slide automatically stops the sound. 
b.   When Clicked: This setting starts playing the sound only when you click the speaker icon. 

Navigating to the next slide automatically stops the sound. 
c. Play Across Slides: This setting starts playing the sound automatically and it continues 

playing as you navigate to subsequent slides. 

 
d.   Click on the Office tab and select New.  
e.   Select Sample Templates. 

 

 
 
 
 

http://office.microsoft.com/en-us/getstarted/FX101055081033.aspx
http://office.microsoft.com/training/training.aspx
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f. Select Introducing PowerPoint 2010 from the Sample Templates area.  

g.   This will give us an actual finished PowerPoint to work from. 
h.   Click on Create. 
i. Slide 1 should appear. 
j. Choose Insert, Clip Art. 

 

 
 

k. Type “classical” in the Search for box. 

 

 
 

l. Click in the Search box and type: classical.  
m.  Click the Selected media file types arrow and place a check in the Audio box only. 
n.   Click Go. 
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o.   Click the down arrow button and single click on thet: Classical   
       Winds sound icon to insert it on the slide. 

p.    A speaker icon will appear that you can click and drag to reposition     
       it. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

q.   C l i c k  o n  t h e  Pl a y bac k  t a b  to  se e  a l l  t he  o p t i ons  t ha t  yo u  c an  d o  w i th   
    t h i s  so un d  c l i p .  
r.    Click on the play button to start the sound and the esc key on keyboard to stop it.  

 
2.  Acquiring More Sounds 

 
Beware of copyright laws when downloading sound files. Some websites have free sounds, but make 
sure you read the fine print and make sure it is really copyright free. WAV files are much larger than 
MP3 files so if you have longer sound files, you should try to use the MP3 format. 

 
a. Click Slide 2, Enhancing Your Presentation 
b. Choose Insert, Audip – From File 
c. On left window, click on: My Computer and navigate    
       to the HP Jump Drive to access files and          
      Double Click on the Int Ppoint 2007 folder.  
d.   Double Click on the sound file “iowa fight  
       song.wav”. 

 

 
 
Another speaker icon should appear that works the same way as the prior 
sound clip and you can refer to the Playback tab for various options. 
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f. Click f5 on your keyboard to start the presentation and listen to your newly inserted  
       sound clips. 

 

Adding a CD Music Track  

Unfortunately, the new version of PowerPoint does not allow you to insert a CD audio file 
from a music CD.  It must have been saved in your computer or have downloaded it from 
the Internet. 

Finally, you can record audio into your presentation if you have a microphone attached to 
your computer. This option may not be available on the lab computers since there is not a 
microphone installed on these machines.   Below is an example of what the window would 
look like. 

 

 

 

The Sound Tools bar allows you to configure the settings for the sound that you just 
inserted. 

 

You can preview the sound by clicking on the green button at the far left. You can adjust 
the volume of the sound to Low, Medium, High, or Mute and other options. 

The Hide During Show checkbox will hide the audio icon that is currently in the slide. By 
default, that audio icon will show up, so check this box if you want to hide it. 

The Loop Until Stopped box will continuously play the audio file you specified until the 
PowerPoint presentation is over. 
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Start Sound has several options: Automatically, On Click, and Play Across Slides. By 
default, On Click is selected and will play when the speaker icon is clicked on.  Play 
Across Slides will allow the sound to continue to play to the next slide if it has not finished 
rather than cutting it off. 

Finally, you can also Trim the file size for the audio file if you only want to play a certain 
part of the song.   

3.  Insert a Video Movie into a Presentation 
 

PowerPoint uses the term Video to generically describe full-motion video and animated GIFs. 
MPEG files are generally smaller files compared to AVIs and are less problematic when playing 
on different computers. AVI files can be problematic because of missing codecs. 

 
a.   Choose Home, make sure your on Slide 1 and then choose: New Slide for Title and Content. 

 

 
 

b.   Click the Insert Media Clip icon on the slide. 

 

 
 

c. Navigate to…My Computer…HP Jump Drive…to the Int Ppoint 2007 folder, select the   
      “Find_Your_New_Favorite.wmv”video movie file, and Click OK. 

d.   Choose on the Playback tab your option: On Click, Automatically, Play    
      Across Slides, etc.    
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e.   Choose View, Slide Show to show your presentation (or f5). 
f. Move your mouse around until the mouse pointer becomes visible. 
g.   Click the movie placeholder to start the movie.  
i. Save your presentation. 
 
 

 

4.  Setting Movie Options 
 

Just as with sound, there are several options you can apply to movies on a slide. 

 
a.   Play Movie: You can choose to automatically start the movie when the slide loads, or require 

the movie to be clicked in order to play. If set to Play Across Slides, only the audio portion of 
the movie will play across subsequent slides. 

b.   Hide While Playing: You can hide the movie placeholder during a slide show. However, this 
will make it impossible to click the movie to start it! Use this option when Play Movie is set to 
Automatically or Play Across Slides. When the movie ends, it disappears (hides) so your slide 
doesn’t display a rectangular placeholder. 

c. Play Full Screen: You can have the movie play in full-screen mode. When set to full-screen 

mode, the movie appears as normal on the slide but enlarges to fill the screen when played. 
When the movie is done, the size automatically reduces and the entire slide is once again 
visible. 

d.   Loop Until Stopped: The movie can be configured to rewind and start over again and 
again until manually stopped. 

e.   Rewind Movie After Playing: This is helpful when you want to play the movie only once, but 
have it ready to start playing from the beginning again when clicked. 

f. Slide Show Volume: Just as the name indicates, you can set the volume for the audio 

playback of a movie. This option sets the initial volume, which can be overridden by your 
computer speakers’ volume control. 

 
 

Photo Album 

Creating a photo album in Microsoft Office PowerPoint 2010 from pictures on your hard disk or other 
storage media is a great way to share photographs or other illustrations. You can customize the album by 
using layout options such as frames of different shapes, and you can add captions to each picture. 

This article shows how you can create a photo album in PowerPoint 2007 in just six quick steps. The 
example used in this article assumes you are creating a photo album with two slides: a title slide and a slide 
that displays four pictures of items being offered for sale. 

To begin…let’s start a new presentation with CTRL + N on your keyboard.   

Step 1 – start a photo album 

On the Insert tab, in the Illustrations group, click the Photo Album button icon (not the drop-down arrow). 
The Photo Album dialog box opens. 
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Step 2 – insert pictures 

Click the File/Disk button. In the Insert New Pictures dialog box, navigate to the Sample Pictures folder 
on your jump drive containing 4 photos you want to include in the album. Double Click on each file (Winter, 

Water Lilies, Sunset & Blue Hills or other titles – may be different), to insert them. 

In the Photo Album dialog box, the Pictures In Album list includes the four graphics you selected. You can 
select each picture in turn to view it. You can change the order in which the pictures will appear in the album 
by clicking the picture you want to move and then clicking the Move Up or Move Down button. You can 
also adjust the rotation, contrast, and brightness of each picture. 

Step 3 – create the album layout 

Under Album Layout, click the Picture layout arrow, and then in the list, click 4 pictures with title. 
Click the Frame shape arrow, and in the list, click Rounded Rectangle. Then click Create. 
PowerPoint creates a presentation called Photo Album that contains a title slide and a slide containing the 
four pictures. 
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Step 4 – Create Titles and Subtitles 

On Slide 1, select the words Photo Album text box, and then type the title you want for your album. In our 
example, we titled our album “Relaxing Photos”. Then give your album a subtitle (by followed by your first 
and last name).  

Display Slide 2, click the title placeholder, and then type the title for this slide. The title for our second slide 

is “Nature of Beauty.” 

Step 5 – format pictures 

Our inserted pictures seem to be properly sized, but if needed, you can readjust them individually by: 
selecting each picture, and on the Format contextual tab, click the Size Dialog Box Launcher, and on the 
Size tab of the Size and Position dialog box, set the Height and Width to the desired size (by clicking the 
up/down arrows), and then click Close.   Adjust the positions of the pictures as necessary. 

 

Step 6 – edit the photo album 

On the Insert tab, in the Illustrations group, click the Photo Album arrow, and then click Edit Photo 
Album. 

In the Edit Photo Album dialog box, under Picture Options, select the Captions below ALL pictures 
check box, and then click Update. 

Click on Slide 2 and Replace the file names below each photograph with suitable captions, and then click a 
blank area of the slide.  In our case, the file names were already given proper names, but they can be 
changed.   
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On the Design tab, in the Themes group, display the Themes gallery, and select a theme that showcases            

                                 the pictures. We chose the Paper theme. 

 

 

The End. 
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